
Contents for KX-P6300/P6500/P6100 Console Help
The KX-P6300/P6500/P6100 Console provides a single access point to the four major KX-P6300 
/P6500/P6100 program screens. The purpose of the KX-P6300/P6500/P6100 Console is to provide an 
easy method to configure the KX-P6300/P6500/P6100 printer and to monitor and control print jobs. To 
activate the KX-P6300/P6500/P6100 Console, double-click the KX-P6300/P6500/P6100 Console icon. 
Each of the four major program features can be viewed by clicking the folder tab under the Window menu 
bar.

The four program screens are:
*    Local Queue
*    Remote Queue
*    Job Log
*    Control Panel
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Introduction
The KX-P6300/P6500/P6100 is a new-generation printer developed for Windows users. It consists of a 
laser printer and Windows printing software. The KX-P6300/P6500/P6100 uses the power of your PC 
under Windows to create fast, high quality laser output. As you add memory or move up to a more 
powerful PC, the KX-P6300/P6500/P6100's performance will increase along with your system.

The KX-P6300/P6500/P6100 software allows you to select from two different printer modes (GDI Mode 
PCL Mode). Both Windows applications and DOS applications running within Windows can use PCL 
mode for printing.



System Requirements
Operating system:
Windows 3.1 or greater in Enhanced Mode, and MS-DOS 3.3 or later.

PC:
An IBM-compatible PC with at least a 386SX 16MHz CPU for Windows 3.1 or Windows for Wordgroups 
3.11 (a 386DX 16MHz CPU for Windows 95). This includes all 486 based and most 386-based PCs. 
Some older 386s cannot run in Windows Enhanced Mode, which means the KX-P6300/P6500/P6100 will 
not work properly on those systems. The KX-P6300/P6500/P6100 will not run on 286-based PCs and 
other earlier systems. If you have Windows installed on your PC, you can verify whether it runs in 
Enhanced Mode by typing WIN/3 at the MS-DOS prompt. If your PC cannot run Windows in the 
Enhanced Mode, the system will tell you.

I/O:
Standard PC parallel printer port and cable.

Memory:
At least 4 megabytes PC memory (RAM), which is also the minimum amount of memory recommended 
by Microsoft for use with Windows. Adding more memory to your PC will increase overall system and 
printer performance.

Disk space:
About 4 megabytes disk space for files, and up to approximately 12 megabytes disk space for virtual 
memory. You can see or modify your Virtual Memory through the Windows "Control Panel".

Allocating Virtual Memory

Restrictions:
    1.    Due to the nature of the high-speed interface, the KX-P6300/P6500/P6100 printer cannot be shared

through a network or switch box.
    2.    The KX-P6300/P6500/P6100 works with a standard parallel cable. Be aware that some 

manufacturers cut corners by manufacturing cables that do not conform to standard parallel 
specifications.



Allocating Virtual Memory
The KX-P6300/P6500/P6100 software requires a minimum of 12MB of virtual memory for Personal, Client
and Server configurations. To change the virtual memory, follow the instructions below. (For more 
information on virtual memory, refer to the Microsoft Windows User's Guide)

For Windows 3.1 or Windows for Workgroups 3.11
      1.        Double click on the "Main" icon from the "Program Manager" screen.
      2.        Double click on the "Control Panel" icon.
      3.        Double click on the "386 Enhanced" icon.
      4.        Click "Virtual Memory". "Virtual Memory" dialog box will be displayed.
      5.        If the size shown in the "Virtual Memory" dialog box is less than 12,000 KB, then click "Change". 

Otherwise click "Cancel" to exit the dialog box.
      6.        Increase the New Size in the "New Settings" box to at least 12,000 KB.
      7.        Select the Type "Permanent" in the New Settings box. If you cannot obtain the correct memory 

size using "Permanent", then select "Temporary".
      8.        Click "OK".
      9.        Click "Yes".
 10.        Click "Restart Windows" to make the settings effective.

For Windows 95
      1.        Click the "Start" button, move the pointer to "Settings" and click "Control Panel".
      2.        Double click the "System" icon. "System Properties" window will be displayed.
      3.        Click the "Performance" tab.
      4.        Click "Virtual Memory...".
      5.        Click "Let me specify my own virtual memory settings" button.
      6.        Increase the Minimum setting to at least 12.
      7.        Click "OK".
      8.        Click "OK".
      9.        Click "Close".
 10.        Click "Yes" to restart Windows.



Local Queue
The Local Queue is used to review the status of your queued print jobs. For Servers, all pending print 
jobs are local to the Server. For Clients, the Local Queue represents print jobs that have been queued to 
a remote Server but are not yet transferred to that remote Server.
For Servers, checking on the Show My Jobs Only will display your print jobs only.

The job queue presents:
      *        the print job name
      *        the format of the print job (GDI, PCL)
      *        the size in bytes of the print job
      *        the time the job was sent to queue
      *        the owner of the print job

The job owner category is primarily applicable to Server. The Local Queue presents the status of the job 
currently printing. For Clients, this status will display only when the Client's print jobs are printing.
Both Servers and Clients can highlight then drag-and-drop jobs within the Local Job Queue to reorder the 
print queue. Drag-and-drop is available for jobs that have not started printing.

To drag and drop, perform the following steps:
        1.      Place the mouse cursor at the beginning of the print job you want to select.
        2.      Press and hold the left mouse button.
        3.      While holding the left mouse button down, move the mouse. As you position the mouse, print 

jobs will be highlighted.
        4.      Move the mouse to the last print job you want to select.
        5.      Release the left mouse button. The print job will remain highlighted.
        6.      Return the mouse cursor to the beginning of the selection. Note the I-bar cursor turns into an 

arrow when the cursor is in the highlighted area.
        7.      Depress and hold the left mouse button.
        8.      While holding the left mouse button down, move the mouse arrow to the place you wish to drop 

the selected print job(s).
        9.      Release the mouse button.

Note:
Print Job in the Local Queue will be displayed only when "Use Panasonic KX-P6X00 Print Manager" is 
selected in the Panasonic GDI window.

Buttons

 Pause  Resume

 Add  Delete

Remote Queue
The Remote Queue is used to review the status of your queued print jobs at the remote printer. This 
queue is primary for Clients to review their print jobs on the remote printer. Clients can select among the 
available shared printers through the Show Print Queue for list box.
For clients, checking on the Show My Job Only will display your print jobs on the Servers. And checking 
on the Show Server will display all the servers with their status.



The job queue presents:
      *        the print job name
      *        the format of the print job (GDI, PCL)
      *        the size in bytes of the print job
      *        the time the job was sent to the queue
      *        the owner of the print job

The server information presents:
      *        the server's name
      *        the status of the print job
      *        comments

The job owner category is primarily applicable to the Server. The drag-and-drop feature is not available in 
the Remote Queue.

Note:
Print Job in the Remote Queue will be displayed only when "Use Panasonic KX-P6X00 Print Manager" is 
selected in the Panasonic GDI window.

Buttons

 Pause  Resume

 Add  Delete

Job Log
The Job Log provides a historical log of the last 10 jobs queued for print.

The Job Log presents:
      *        the time the job was printed
      *        the Server's name of the print job
      *        the job name
      *        the format of the print job (GDI, PCL)
      *        print result

The Job Log is more useful for Clients in workgroup environments, where there are multiple printers 
supporting different printer characteristics.

Note:
Print Job in the Job Log will be displayed only when "Use Panasonic KX-P6X00 Print Manager" is 
selected in the Panasonic GDI window.



Control Panel
The Control Panel provides the mechanism to configure and control the printer. The Control Panel is 
divided into six button categories, the printer information, and printer selection display. The Printer group 
item presents the currently selected printer and provides a list of additional printer selections.

The printer selections applicable to your printer are:
      *        Panasonic KX-P6300/P6500/P6100 GDI
      *        Panasonic KX-P6300/P6500/P6100 PCL

Use the list bar to highlight the print mode you want to use. Then to apply the selected printer, click the 
Set As Default button. You can also request the current printer status through the Local Printer Status 
button.

Buttons

 Toner Saving  EET

 Density  Power Saving

 Printer Setup  Connect Port

 PCL Control Panel  DOS Printing Options

 Share Printer  Connect to

 Client Monitor  Status Report Options

 Print Test Page

Set As Default
Local Printer Status



File Menu Commands
The File menu provides selection to exit your application.

Pause Printer:
Pause Printer lets you pause the current print job. Once paused, you can use the Resume button to 
continue printing, or cancel the print job by clicking the Delete button.

Resume Printer:
Resume Printer lets you resume printing a job that has been paused.

Add document:
Add document lets you select a print job file in PCL or GDI format and add it to the end of the print queue.
Be sure to select the correct file format (GDI, PCL) for the file you wish to print.

Delete document:
Delete document lets you cancel a current printing job that has been paused. You can also use the mouse
to select a job that has not started printing, then click on Delete to remove it.



View Menu Commands
The View menu allows you to show all servers with their status.



Settings Menu Commands
The Settings menu allows you to define the default settings.

Toner Saving (available for KX-P6500/KX-P6100):
Allows you to choose from three toner saving modes: (settings: Light, Medium, Dark, Off) The Off 
selection is for regular print toner use. Toner Saving modes can significantly reduce toner costs by 
extending the life of your toner cartridge.

EET(Edge Enhancement Technology) (available for KX-P6500/KX-P6100):
With Edge Enhancement turned on, the printer will smooth the jagged edges of text and line art, giving 
the output a very high quality appearance. There are three settings: Light, Medium, and Dark. The 
factory default setting is Medium. If the EET setting is too dark, the edges appear to bulge.
The test page has an Edge Enhancement test block. As a general guideline, select the EET setting so as 
to make this block look like a uniform gray block with no vertical lines in it. If there are white vertical lines 
in it, set the EET to darker setting. If there are darker vertical lines in it, set the EET to a lighter setting.

Density:
The density options lets you choose from Level 1 to Level 5. To make print lighter, choose a lower level. 
To make print darker, choose a higher level.

Power Saving:
With Power Saving turned on, you can save energy by instructing your printer to enter a low power 
consumption if data is not received by the printer for 15 minutes.

Printer Setup:
The Printer Setup displays the primary printer settings and configuration dialogue that also provides 
advanced setting and features.

Setup Screen:
*    KX-P6300/P6500/P6100 GDI Printer
*    KX-P6300/P6500/P6100 PCL Printer

Connect Port:
The Connect Port option lets you select a different parallel port for your printer. Depending on what your 
PC has available, you can choose either LPT1, LPT2, or LPT3.

PCL Control Panel:
PCL Control Panel displays the PCL Control Panel dialogue. This Control Panel provides configuration 
options for PCL printing from MS-DOS applications printed from the MS-DOS icon command line under 
Windows.

DOS Printing Options:
This Option allows you to configure how DOS print job within Windows printing is to be processed.

Printer Priority:
The KX-P6300/P6500/P6100 Print Manager lets you select Low, Medium, or High Priority printing. If you 
want faster printing, set the priority to High. If you want to maximum use of other applications and don't 
mind waiting longer for output, set the priority to Low.

Local Printer Change:
This selection will search which printer, KX-P6300,KX-P6500, or KX-P6100, is connected to serve as a 
local printer and will automatically change the printer driver to the corresponding printer model.



Network Menu Commands
The Network menu allows you to share and connect to a network printer, monitor Client (if configured as 
a Server), and change status settings, such as print job notifications.

Share Printer:
This selection is only available to Server configured users. When selected it will set the printer as Shared.

Connect to:
This selection is available to Client and Server configured users. When selected it will present a list of 
available printer Servers can be selected.

Client Monitor:
This selection is available to the Server and provides the capability to monitor the print activities of Clients
using the printer.

Notify:
This selection is available to all users and defines the various status selections and their display options.

Change Name:
This selection is available to all users and allows the user to change the computer name. You must exit 
and restart Windows before this change takes effect. The new computer name must not exceed 15 
characters.



Run Menu Commands
The Run menu allows you to examine the status of the printer and print a test page.

Printer Status:
The KX-P6300/P6500/P6100 Local Printer Status has two primary functions.

        1.      To let you monitor the status of the local printer.
        2.      To alert you in the event of a problem with your printer, such as a paper jam.

The KX-P6300/P6100 Local Printer Status display provides two printer status (four for KX-P6500) lights, 
two information boxes, and printer control buttons. The Printer status lights mimic what you would 
normally see on a non-host-based printer and provide a quick view of the printer status through the 
following:

* Ready Indicates the printer status is OK or processing a print job.
* Error Indicates an error condition has been detected.

The following status is provided when using KX-P6500.
* Toner Indicates that the toner must be replenished.
* Process unit Indicates that it is time to replace process unit.

The top information display box presents the current printer status and provides an icon if there is an error
that represents the error condition. The bottom information box provides job specific information if a print 
job is printing or has been paused.

Printer Test Page:
This selection allows you to print configuration page.

Close Interpreter:
This selection can clear the PCL Printer icon after a DOS application has been printed using the KX-
P6300 or KX-P6100.



Help Menu Commands
The Help menu links you to KX-P6300/P6500/P6100 Help system.

Index:
To see KX-P6300/P6500/P6100 Console Help.

About:
Show version and copyright information.



Pause
This selection allows you to pause printing.



Resume
This selection allows you to resume printing.



Add
This selection allows you to add a print job to the print queue.



Delete
This selection allows you to delete the highlighted print job from the print queue.



Toner Saving (available for KX-P6500/KX-P6100)
With Toner Saving(TonrSavR) turned on, your printer will reduce the amount of toner used to print. Black 
areas and text are replaced by a light gray shading. (settings: Light, Medium, Dark, Off).



EET(Edge Enhancement Technology) (available for KX-P6500/KX-
P6100)
With Edge Enhancement turned on, the printer will smooth the jagged edges of text and line art, giving 
the output a very high quality appearance. There are three settings: Light, Medium, and Dark. The 
factory default setting is Medium. If the EET setting is too dark, the edges appear to bulge.
The test page has an Edge Enhancement test block. As a general guideline, select the EET setting which 
makes this block look like a uniform gray block with no vertical lines in it. If there are white vertical lines in 
it, set the EET to a darker setting. If there are darker vertical lines in it, set the EET to a lighter setting.

Note:
The Density settings interact with EET. When you change the Density, readjust the EET setting.



Density
The Density setting allows you to define the darkness of the dots placed on the paper. There are settings 
from Level 1 to Level 5. The default is Level 3. To lighten, choose a lower level. To darken, choose a 
higher level.



Power Saving
With Power Saving turned On, you can save energy by instructing your printer to enter a low power 
consumption mode if data is not received by the printer for 15 minutes.



Printer Setup
The Printer Setup displays the primary printer settings and configuration dialogue that also provides 
advanced settings and features.

Setup Screen:
*    KX-P6300/P6500/P6100 GDI Printer
*    KX-P6300/P6500/P6100 PCL Printer



Connect Port
The Connect Port option lets you select a different parallel port for your printer. Depending on what your 
PC has available, you can choose either LPT1, LPT2, or LPT3. Your PC hardware configuration may limit
your individual options.



PCL Control Panel
The KX-P6300/P6500/P6100 was designed to print with Windows. However, many Windows users need 
to run MS-DOS applications occasionally. The KX-P6300/P6500/P6100 lets you print from MS-DOS 
applications, however, you must run the application from Windows, or within the DOS box under 
Windows. The KX-P6300/P6500/P6100 also provides a PCL Control Panel for DOS PCL printing. This 
allows you to change printer settings for your DOS print jobs. (Note: Some DOS applications may 
override these settings.) While the PCL Control Panel is included primarily for DOS print jobs, it also can 
effect the default settings for Windows PCL print jobs. However, the Windows KX-P6300/P6500/P6100 
PCL printer driver overrides the corresponding settings in the PCL Control Panel.

The PCL Control Panel screen lets you change the following settings:
Paper Size
Paper Source
Copies
Orientation
Default Font
Margins

The followings are available for KX-P6500 PCL Control Panel.
Lines / Page
Auto Continue
Page Protection

Buttons

 Form Feed  Reset  Help

Defaults
OK
About
Cancel



Paper Size
Size lets you change to a different paper size. First, click on the Size box, then scroll through the 
selection. When you see the paper size you want, click on it.

Regular Paper:
Letter 8 1/2 x 11 inch (215.9 x 279.4 mm)
A4 210 x 297 mm (8.27 x 11.7 inch)
Executive 7 1/4 x 10 1/2 inch (184.1 x 266.7 mm)
Legal 8 1/2 x 14 inch (215.9 x 355.6 mm)

Envelopes:
Monarch 3 7/8 x 7 1/2 inch (98.5 x 190.5 mm)
Envelope #10 4 1/8 x 9 1/2 inch (104.9 x 241.3 mm)
International DL 110 x 220 mm (4.33 x 8.66 inch)
International C5 162 x 229 mm (6.4 x 9.02 inch)



DOS Printing Options
This option provides the versatility of printing a DOS Application within Windows. In particular, KX-
P6300/P6500/P6100's GDI mode is based on Windows and does not work with MS-DOS. However KX-
P6300/P6500/P6100 will work in PCL mode if you create an MS-DOS session from within Windows.
Enter MS-DOS from Windows.(Click on the DOS application icon, or click on the MS-DOS icon and run 
your application from the command line.)
Set up your application to print to the parallel port LPT1 (or LPT2 or LPT3 if previously selected). Be sure 
your application's PCL driver is installed. Select a printer driver.
When ready to print, start your DOS application and print as you would normally do so, to LPT1 (or 
whichever port KX-P6300/P6500/P6100 is connected to).

You can select Spool as PCL 4.5 or Direct to Port in the Printing Mode list box. If you use 
KX-P6300/P6500/P6100 or KX-P6100, Select Spool as PCL 4.5.
Spool as PCL 4.5: makes the PCL Control Panel settings effective.
Direct to Port: makes the DOS application's settings effective. (available for KX-P6500)
Some applications may not operate properly if the Spool as PCL 4.5 has been selected. In that case, 
select Direct to Port.



Print Priority
Windows lets you run several applications at the same time. This helps productivity but means you are 
sharing your PC resources among several activities.
The printer's priority settings let you control the priority of the printing activity relative to other applications 
running at the same time.

You can select High, Medium, or Low priority. Printing at high priority produces output faster but may slow 
down your system more than the other priority settings. On the other hand, printing at lower priority lets 
your other applications run faster but also means your document will take longer to print.



Local Printer Change
This selection will search which printer, KX-P6300,KX-P6500, or KX-P6100, is connected to serve as a 
local printer and will automatically change the printer driver to the corresponding printer model.



Status Report Options
This selection in the Options menu controls the Status Display.

Minimize Print Status Display:
This option minimizes the Printer Status Display.

Remote Status Report:
This option tells the KX-P6300/P6500/P6100 to display a dialog box if an error condition occurs at a 
remote printer. If this selection is turned off, the KX-P6300/P6500/P6100 will not display a dialog box if an 
error condition has occurred.

Notify When A Job Is Finished:
This option tells the KX-P6300/P6500/P6100 to display a dialog box whenever it finishes a job. If you turn 
this selection Off, the KX-P6300/P6500/P6100 will not display a dialog box when a job has finished.

Notify When A Job Is Deleted:
This option tells the KX-P6300/P6500/P6100 to display a dialog box whenever it deletes a job. If you turn 
this selection Off, the KX-P6300/P6500/P6100 will not display a dialog box when a job has been deleted.

Beep When Print Job Is Complete:
This option tells KX-P6300/P6500/P6100 to beep when it finishes printing a document. If you turn this 
selection Off, KX-P6300/P6500/P6100 will make no sound when printing has finished.

Beep on Printer Error:
This option tells the KX-P6300/P6500/P6100 to beep whenever it encounters a printer problem, such as 
when the printer runs out of paper. If you turn this selection Off, the KX-P6300/P6500 /P6100 will display 
an error message, but will not beep if a problem occurs.



Print Test Page
This selection allows you to print configuration page.



Close Interpreter
This selection can clear the PCL Printer icon after a DOS application has been printed using the KX-
P6300 or KX-P6100.



GDI Mode
Provides fast, WYSIWYG output by taking advantage of Windows' native graphics and text features.



PCL Mode
Enables you to print a file created with the MS-DOS application or to print a PCL format file within 
Windows.



Set As Default
You can select the print mode on the list bar. This selection applies to the selected printer.



Local Printer Status
The KX-P6300/P6500/P6100 Local Printer Status has two primary functions.

        1.      To let you monitor the status of the local printer.
        2.      To alert you in the event of a problem with your printer, such as a paper jam.

The KX-P6300/P6100 Local Printer Status display provides two printer status (four for KX-P6500) lights, 
two information boxes, and printer control buttons. The Printer status lights mimic what you would 
normally see on a non-host-based printer and provide a quick view of the printer status through the 
following:

* Ready Indicates the printer status is OK or processing a print job.
* Error Indicates an error condition has been detected.

The following status is provided when using KX-P6500.
* Toner Indicates that the toner must be replenished.
* Process unit Indicates that it is time to replace process unit.

The top information display box presents the current printer status and provides an icon if there is an error
that represents the error condition. The bottom information box provides job specific information if a print 
job is printing or has been paused.

Buttons

 Expand (Reduce)  Pause

 Resume  Delete

Paper Source
Main Tray is the only paper source.



Paper Size
Size lets you change to a different paper size. First, click on the Size box, then scroll through the 
selection. When you see the paper size you want, click on it.

Regular Paper:
Letter 8 1/2 x 11 inch (215.9 x 279.4 mm)
A4 210 x 297 mm (8.27 x 11.7 inch)
Executive 7 1/4 x 10 1/2 inch (184.1 x 266.7 mm)
Legal 8 1/2 x 14 inch (215.9 x 355.6 mm)
A5 148 x 210 mm (5.83 x 8.27 inch)
B5 182 x 257 mm (7.17 x 10.12 inch)

Envelopes:
Monarch 3 7/8 x 7 1/2 inch (98.5 x 190.5 mm)
Envelope #10 4 1/8 x 9 1/2 inch (104.9 x 241.3 mm)
International DL 110 x 220 mm (4.33 x 8.66 inch)
International C5 162 x 229 mm (6.4 x 9.02 inch)



Orientation
For Orientation, choose Portrait or Landscape. If you choose Portrait, your output appears with the 
paper's shorter edges at top and bottom, and longer edges at the side, like a business memo. If you 
choose Landscape, your output appears with the longer edges at the top and bottom, and the shorter 
edges at the sides. Landscape is sometimes used for graphs, spreadsheets, and presentation slides.



Copies
Copies identifies how many copies of your document will be printed.



Default Font
Default Font lets you select the default typeface, size, and style for print jobs that are output from MS-
DOS applications run under Windows, and for Windows PCL print jobs. Both MS-DOS and Windows 
applications can override the default font selection.
Please note you do not have access to Windows TrueType fonts for MS-DOS print jobs.



Margins
The Margins settings let you define the top, bottom, left, and right margins for PCL print jobs. Please note 
that DOS and Windows applcations may override these settings.



Lines / Page (available for KX-P6500)
Lines / Page identifies how many lines of your document page will be printed.



Auto Continue (available for KX-P6500)
Auto Continue lets you select the error condition recovered automatically. If you choose On, error 
condition recovered automatically and goes ON LINE. If you choose Off, error conditions are not 
automatically recovered.



Page Protection (available for KX-P6500)
Page Protection lets you select the reserve additional memory for PAGE PROTECTION. If you choose 
Automatic, it additionally reserves memory to process the entire page (in memory) composed with very 
dense or complex graphics and text before printing out of page. This setting assures complete printing. If 
you choose Off, it does not reserve additional memory.



Form Feed
Some PCL files do not include a form feed (a command to eject a page) at the end of the file, so the last 
page will not be printed. If this happens, you must click the Form Feed button to print it out.



Reset
After clicking the Reset button, the current displayed PCL Control Panel settings will be saved and the 
saved settings will be applied to succeeding PCL jobs. Present PCL printing job will not be affected.



Help
Help provides information about the PCL Control Panel and its settings.



Cancel
Clicking Cancel will lose any changes you have made to PCL printer settings, and will exit the PCL 
Control Panel.



Defaults
Click on Defaults to restore all printer settings on the screen to their default values.



About
About presents the KX-P6300/P6500/P6100 PCL Control Panel version and copyright information.



OK
Click on OK for your changes to take effect and will exit the PCL Control Panel.



Light
Text and objects on the page have a black outline along their left edge.



Medium
Text and objects on the page have a black outline along their left and right edges.



Dark
Text and objects on the page have a black outline along all edges. This setting is recommended over 
Light and Medium if you expect to fax or photocopy the document.



Off
This is the default setting and is recommended for the highest print quality.



Share Printer
This selection is only available to Server configured users. When selected it will set the printer as Shared.



Connect to
This selection is available to Client and Server configured users. When selected it will present a list of 
available printer Servers that can be selected.



Client Monitor
This selection is available to the Server and provides the capability to monitor the print activities of Clients
using the printer.



Change Name
This selection is available to all users and allows the user to change the computer name. You must exit 
and restart Windows before this change takes effect. The new computer name must not exceed 15 
characters.



Expand
This selection allows you to expand the Printer Status Display. This is useful when an error has occurred 
and you want more detailed information about the recommended solution.

(Reduce)
This selection allows you to reduce the Printer Status Display.



Resume
This selection allows you to resume printing if a print job is pending or in the middle of a print. There may 
be some error conditions that upon fixing the problem the printer will resume automatically, however, 
some error conditions require you to resume the printer after the problem was fixed.



Delete
This selection allows you to delete the job that is currently printing. You must pause the job before you 
can delete it, unless the printer itself is paused because of an error.



KX-P6300/P6500/P6100 GDI Printer Setup Screen
You can access the Setup screen from the Setup or Print Setup feature of many applications. You can 
also reach it from the Printers screen of the Windows Control Panel.

The Setup screen lets you change the following settings:
Paper Source
Orientation
Paper Size
Copies
Resolution
Enable Photo Enhancement
Use KX-P6X00 Print Manager

Buttons
OK
Cancel
Options
2Up/4Up
About



Enable Photo Enhancement (available KX-P6500/KX-P6100)
Clicking on Enable Photo Enhancement will improve the appearance of the images and graphics in your
printed documents. With Photo Enhancement turned On, a printed image appears closer to a real 
photograph. In other words, when compared to normal printer output, the image looks smoother and finer,
with overall higher quality. Photo Enhancement works by increasing the number of shades of gray 
available on your printer. Printer output normally consists of a number of small dots on a page. (The 
printer's resolution is measured in dots per inch, or dpi.) Photo Enhancement actually subdivides these 
dots into a large number of smaller subdots, and controls the position of those subdots through 
sophisticated algorithms. This increases the number of shades of gray that you see in images and 
graphics, and at the same time reduces the grain or coarseness. However, by enabling photo 
enhancement the printer will require more time to print a document.
When Photo Enhancement is enable, there may be situations where a printer overrun occurs. If this 
sutuation occurrs, you may select one of the following options.

a. Turn Photo Enhancement Off and print at 600 dpi.
b. Add an optional memory upgrade. (Contact your Panasonic dealer for details)

Note:
This feature may not be effective for some applications.



Use KX-P6X00 Print Manager
The Use Panasonic KX-P6X00 Print Manager extends the GDI print capabilities to allow access to 
extended GDI functions, such as duplex, overlay, and reverse order printing. Turning off the KX-P6X00 
Print Manager, by removing the X in the check box, will make GDI mode even faster.

Note:
Print Job in the Local Queue will be displayed only when "Use Panasonic KX-P6X00 Print Manager" is 
selected in the Panasonic GDI window.



Resolution
You can determine the quality of your output by changing the printer's print quality settings. Each setting 
is a different resolution, measured in dots per inch (dpi) on the page. Higher resolution results in better 
quality output, but may take longer to print. The available settings are 600 dpi or 300 dpi.



OK
Click on OK to make your changes take effect and return to the previous screen.



Cancel
Click on Cancel to ignore any changes you have made and return to the previous screen.



2Up/4Up
The printer lets you print 2 or 4 pages on a single sheet of paper.
Select 2 up:    if you want the printer to print two pages on one sheet of paper. (In portrait mode, the pages
show up side by side as if in a book.)
Select 4 up:    if you want the printer to print four pages on one sheet of paper.
Select 1 up:    if you wish to print normally.

Draw Frame Border:
If you click on Draw Frame Border, the printer will draw a box around each page on the paper.

Note:
In Landscape mode, the pages are printed in different order.
The resolution will be fixed to 300 dpi automatically when 2up/4up feature is selected. (Only in case 
Windows 3.1 or Windows for Workgroups 3.11)



About
About presents the KX-P6300/P6500/P6100 program version and copyright information.



Options
The Options are provides advanced GDI features, such as duplex, overlay, and reverse order printing. To 
gain access to these features, click the Use Panasonic KX-P6X00 Print Manager.

Duplex Printing:
The Manual Duplexing features allows double-sided printing of your file. The printer will print every other 
page first, for example pages 1, 3, 5, and so on. The KX-P6300/P6500/P6100 printer will request you 
reinsert the printed pages and the printer will print the even numbered pages, for example pages 2, 4, 6, 
and so on. Off will disable Manual Duplexing. There are two manual duplex formatting options (Book, 
Report).
Select Print Instruction Page to case the printer to print a duplex instruction page at the end of the initial 
printing. This page provides instructions and input paper orientation to show you how to turn and reinsert 
the printed pages. Insert the instruction page along with your printed pages. The printer will feed the 
instruction page through the printer before printing your print pages.

Scaling:
Scale is used to reduce or enlarge output on the printed page. Valid scale ranges from 10% to 200%. 
Click on the arrows to increase or reduce the setting or enter a number in the text box.

Print to File:
This selection is used to print your output to a file instead of to the printer. This is useful if you want to 
print from a file later, or print the identical file again later. You can also use Print To File to create an 
overlay form. The print file is stored in GDI format. Use the Add button on the Local Queue of the KX-
P6300/P6500/P6100 Console to print from a file.

Buttons
OK
Cancel
Image
Overlay
Default
Help
Browse



Book
Used to print so that if you open the document in the manner of a book, page 2 and 3 face each other.



Report
Used to print so that the even-numbered pages are upside down, so that if you open the document in the 
manner of a report that is bound at the top, such as a clip board, where pages 2 and 3 face same way.



Default
Click on Default to restore all settings to their default values.



Help
Help provides detailed help on the GDI Setup Options screen.



Browse
After selecting File Name, clicking Browse will let you search for your GDI file in the file system.



Image
The Image Options screen lets you adjust the appearance of images you wish to output. These 
adjustments only apply to certain types of images and gray scale drawings, not to text or black line 
drawings. See the Toner Saving(TonrSavR) section for information on lightening the appearance of text 
and some line art. The displayed figure will change as you move the controls, to give you a rough idea of 
the effect of your adjustments.

Brightness Control:
Drag the Brightness knob or click on the arrows to vary the shades of gray, making the image output 
appear lighter or darker.

Contrast Control:
Drag the Contrast knob or click on the arrows to make the image output appear sharper or smoother.

Note:
These settings are resolution-dependent. This means if you change the resolution via the Print Quality 
option on the Setup screen, you may need to return to this screen to adjust the Brightness and Contrast
settings for the new resolution.
This feature may not be effective for some applications.

Buttons
OK 
Cancel
Default



Overlay
The Overlay Options screen is one of the most powerful features of the KX-P6300/P6500/P6100 
software. The feature lets you overlay an image on top of any document printed in GDI print mode.

You can use this feature to:
        *    Incorporate your letterhead on the first page of a business letter.
        *    Print your logo at the bottom of each page of a set of presentation slides.
        *    Overlay the word "Confidential" on every page of an important document.
        *    Print a special cover page or trailer page for each print job.

Print Cover Page:
Select this feature to print a cover page on a separate page before the reminder of your document.

Print Trailer Page:
Select this feature to print a trailer page on a separate page after the document has been printed.

Print Overlay:
This feature will overlay your image on the pages of your document. The effect is similar to printing your 
image on a transparency, then putting the transparency over your document.
Select 1st to overlay the image only on the first page of the document.
Select All to overlay the image on each page in the document.
Select From to overlay the image on a range of pages within the document.

Buttons
OK
Cancel
Browse
Help



Browse
After selecting Print Cover Page, Print Trailer Page, or Print Overlay, clicking Browse will let you 
search for your GDI file in the file system.



Help
Help provides detailed help on the Overlay Options features screen.
 




